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Solution Explorer  

Solution Explorer provides you with a convenient method for accessing J.D. Edwards 
software. The Solution Explorer is designed to be a flexible, customizable system that can 
adapt to your business needs, thereby helping you adapt to changing conditions and 
requirements.  

Key attributes that distinguish Solution Explorer include:  

• Ease of navigation. Solution Explorer offers a convenient, Web-browser-based, 
customizable gateway to all features and to any internal or external Web site. Using 
task views, you can create and use shortcuts to further speed your navigation and 
shorten your work time. Find It! allows you to quickly search for the programs that 
you need to do your work.  

• Flexibility. Reusable units of work, called tasks, are at the core of the Solution 
Explorer. You use these tasks as the basis to model and create business and 
technical processes that you can modify without implementing costly changes to the 
system.  

• Configurability. You can set up the system so that it displays only the tasks and 
processes that you need for your daily work. You can enable and disable tasks and 
create variations of processes to reflect the needs of the system's users.  

• Ease of use. Solution Explorer allows you to create special tasks, called activators, to 
build key business and technical processes without hard-coding form 
interconnections. Activators launch the Universal Director, which provides a graphical 
interface for the entire process that you create and facilitates passing data between 
forms. The Universal Director also presents the steps of a process in an easy-to-read 
format.  

• Compatibility. The Solution Explorer architecture permits software developers and 
integration partners to produce custom activators that are compatible with both third-
party software applications and with J.D. Edwards software.  

• Accountability. Documentation exists for most tasks in Solution Explorer, which 
eliminates guesswork when you encounter a task. You can also create your own 
documentation for new tasks. Documentation means that information about tasks is 
readily accessible, even as people come and go within your organization.  

How to Use This Guide  

An important fact about Solution Explorer is that different users with different needs can use it 
in many different ways. An end-user who is performing business tasks, such as journal entry, 
can easily access the tasks that are necessary to complete the job. Such a user can access 
Solution Explorer through the Home Page. This user typically is not concerned with 
customizing the Solution Explorer.  

System administrators are most concerned about setting up and maintaining system security. 
These users typically only skim the various sections to acquaint themselves with the basic 
structure of Solution Explorer.  

See Also 
! Solution Explorer in the Foundation Guide 

! Security in the System Administration Guide 
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Solution Explorer Terminology at a Glance  

This guide explains in detail the concepts behind Solution Explorer. The following table briefly 
defines the most essential Solution Explorer terms.  

Solution 
Explorer 
Term  

Definition  

Home Page  A URL for which the contents first appears when the user launches the Solution Explorer. 
You can set the URL by configuring the jde.ini file as shown below. In this example, the home 
page is configured to display the J.D. Edwards Portal.  

[EXPLORER]  

JASWebServer = "toolsjass1"  

JASPortalURL="http://toolsjass1/jdeowportal"  

JASForceEnv=  

ExplorerHomeURL="toolsjass1/jde/portal"  

ExplorerStart=home  

You can also configure the home page to display the last task that the user viewed by setting 
ExplorerStart=task. To define a specific task view, set ExplorerStart=task:1234, 
where 1234 is the task view identifier.  

Solution 
Explorer  

A configurable explorer for J.D. Edwards software and related objects that includes task 
content, when available.  

Tasks  Units of work that you use to build essential business processes. Tasks can be interactive 
programs, batch programs, constants, next numbers, Windows executables, and so on.  

Task 
relationships  

Series of tasks arranged in parent-child relationships that form business processes, such as 
Procure to Pay.  

Task views  Collections of related task relationships, which appear in Solution Explorer.  

Task links  Shortcuts from one relationship to another. The linked task appears in a secondary window in 
Solution Explorer.  

Activators  Special tasks that you use to launch the Universal Director. Activators logically link together 
series of tasks; they allow business and technical professionals to make immediate system 
changes and avoid costly down time.  

Universal 
Director  

A graphical user interface that the system launches when you access a task activator. The 
Universal Director provides a coherent framework for work with activators, as well as the 
mechanism for passing data between the J.D. Edwards software forms that are required to 
complete the activator.  

Qualifier rules If-then statements that you create, apply, and use in conjunction with Solution Modeler as the 
basis for enabling or disabling tasks. The system compares answers to Solution Modeler 
questions to the criteria of the qualifier rules for each task and generates a batch process to 
enable or disable tasks based on the comparison.  

Fine Cut  The process that you use to selectively enable or disable tasks in a task view after you have 
d k i fi i i S l i M d l
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created a task view configuration using Solution Modeler.  

Task View 
Roles  

A variation on a task view that you create using Fine Cut. In defining the role, you selectively 
disable tasks in the task view, and then save the role. The system stores the changes, which 
you can activate as an alternative to the default task view.  

 

Setting Up the Home Page for the Solution Explorer 

The Home Page is generally the first form that a user sees after signing on to the Solution 
Explorer. You can use this form to display information that is relevant to end-users in the 
enterprise. It can be an external Web site, an intranet site, or even an HTML file that is stored 
on any server or network. 

During the installation process, the system creates a directory called PortalLite when you 
install the deployment server. This directory resides in the <baseinstall>\ActivEra\PortaLite 
directory and includes a set of html files that make up the default Home Page. Even though 
this directory is on the deployment server, it can reside anywhere on the network, such as on 
a Web server or even locally on a workstation. 

When the J.D. Edwards client is installed, the system updates the client jde.ini to point to the 
location of the PortaLite directory. For example, if the name of the deployment server is 
DepServer1, and the share name is B7333, the system updates the [Explorer] section of the 
jde.ini file as follows: 

[Explorer] 

ExplorerHomeURL=”\\DepServer1\b7333\activEra\portallite\index.html 

ExplorerStart=INTERNET 

You can change the above parameters in the jde.ini file to display any html file or URL as the 
default Home Page. The table below describes these parameters: 

[Explorer] Parameter Description 
ExplorerHomeURL= The URL or file name of the Home Page that appears when the user 

signs on. By default, the initial page is 
\\Depserver1\b7333\activera\portalite\index.html. 

ExplorerStart= The information that appears when you start Solution Explorer. Valid 
values are: 

• Internet. When you start the Solution Explorer, it displays the 
Internet view first. 

• Task. When you start the Solution Explorer, it displays the last 
task view that the user viewed. To display a specific task view, set 
ExplorerStart=TASK:xx, where xx is the task ID for the 
task view. 
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Initializing and Refining the Configuration  

When you implement J.D. Edwards software, you must set up the Solution Explorer by 
defining your business within the system and specify which tasks will be available to your 
users. To do this, you use a utility called Fine Cut. 

The results that Fine Cut generates (enabling and disabling task relationships) are reflected 
in each of the Solution Explorer task views in which you have run Fine Cut. You can also use 
Fine Cut to refine the configuration. As your business changes over time, you can continue to 
use Fine Cut to enable and disable applicable task relationships. 

You perform the initial configuration for your system using Fine Cut.  

Defining your business system in J.D. Edwards software need not occur within a single 
session. If necessary, you can save your work at any time and return to Fine Cut later to 
continue.  

► To initialize or refine the configuration  

1. In Solution Explorer, choose the task view that you want to refine, and then click the 
Fine Cut button on the Toolbar.  

The system changes the task view menu to indicate enabled and disabled tasks. 
Enabled tasks are indicated by a green checkmark; disabled tasks are indicated by a 
red X.  

2. Expand the task tree in the task view to find a task that you want to enable or disable, 
and then choose a task.  

3. Click either the Enable or Disable button on the Toolbar.  

You can also double-click the task to toggle between the enabled and disabled 
conditions.  

4. Repeat steps 2-4 for each task you want to enable or disable.  

5. When you have finished refining the task list, click the Save button on the toolbar.  

Saving your configuration saves your changes to the Master Task Relationship table 
(F9001), so your changes will be available to all users who access that same 
database. 

If you fail to save the changes, the system cannot store the new parameters, and 
your changes will not remain when you exit from the Solution Explorer and then 
launch it again later.  



 5

Note 
If you are using Fine Cut in a role-based task view, you might want to save your 
changes only for a specific role. To do so, right-click the task view node and select 
Save Role. Performing this task does not update the Master Task Relationship table. 

If you are using Fine Cut in a task view that is not role-based, you might want to save 
your changes as a variant. To do so, right-click the parent task to which you want to 
associate the variant, and then choose Save Variant. Performing this task will not 
update the Master Task Relationship table. 

 

6. Click the Fine Cut button to exit Fine Cut mode.  

7. Click the Show/Hide Disabled Tasks button to toggle between hiding and displaying 
disabled tasks in the current task view menu.  
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Task View Setup  

Task views are groups of tasks arranged in a hierarchical tree structure. Tasks are the most 
discrete units in the Solution Explorer. Tasks are organized into hierarchical tree structures 
inside of task views. J.D. Edwards provides thousands of tasks, and you can add more of 
your own. When placed in a single task view, finding a specific task among thousands might 
be difficult and time-consuming.  

Instead of having only one task view in which all of the tasks in the system appear, the 
Solution Explorer allows you to have many different task views, each displaying only some of 
the tasks in the system.  

Typically, tasks are grouped in a task view because they relate to a common business 
system, process, or function. Logical selection and grouping of tasks in this way can help 
users find the functions that they need. You can further refine which tasks a user sees in a 
task view by designating a task view to be role-based. Role-based task views display only 
those tasks that are associated with the role that the user applied to the task. Users can 
apply only those roles for which they have been granted access.  

Additionally, you can prevent users who have only View access to the Solution Explorer from 
seeing task views that you set as secured.  

See Also  
! Working with Task View Roles and Variants in the Solution Explorer Guide  

! Task Set Up in the Solution Explorer Guide  

! Working with Task Links in the Solution Explorer Guide 

Creating a New Task View  

Create a new task view when you want to create a new category of tasks that you use to 
insert tasks and build task relationships.  

See Also  
! Working with Tasks in the Solution Explorer Guide 

! Creating a Task in the Solution Explorer Guide 

► To create a new task view  

1. On Solution Explorer, choose Add a New Task View from the Tools menu.  

2. On Task View Revisions, complete the following fields and options, and then click 
OK:  

• Task View 

Enter an internal ID for the task view. The ID must be between two and five digits 
and cannot contain alphabetic characters. If you start the ID with more than one 
zero, the system truncates it to a single zero. For example, if you type 005 as an 
ID, the system changes the ID to 05.  
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• Name 

• Description                              

The name and the description do not have to be the same.  

• Secured Task View                        

• Role Based Task View 

If you want users to be able to filter tasks in the task view based on their roles, 
turn on this option.  

Changing a Task View  

You can modify an existing task view. For example, you might want to change the name of a 
task view so that it more accurately reflects the category of tasks in that view.  

See Also  
! Working with Task View Roles and Variants in the Solution Explorer Guide  

! Working with Tasks in the Solution Explorer Guide 

► To change a task view  

1. On Solution Explorer, choose Work With Tasks from the Tools menu.  

Alternately, if you want to change the current task view, right-click the top task view 
node and choose Task Revisions from the menu. Skip to step 5. 

2. On Work with Tasks, choose Task Views from the Form menu.  

3. On Work with Task Views, click Find.  

Use the QBE row to refine your search.  

4. Choose the task view that you want to change, and then click Select.  

5. On Task View Revisions, change any of the following fields and options, and then 
click OK:  

• Name 

• Description                              

The name and the description do not have to be the same.  

• Secured Task View                        

• Role Based Task View 

If you want users to be able to filter tasks in the task view based on their roles, 
turn on this option.  
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Deleting a Task View  

You can delete any task view from the system. Deleting a task view does not delete the tasks 
within the view from the system, however.  

See Also  
! Creating a New Task View in the Solution Explorer Guide 

! Deleting a Task in the Solution Explorer Guide 

► To delete a task view  

1. On Solution Explorer, choose Work With Tasks from the Tools menu.  

2. On Work with Tasks, choose Task Views from the Form menu.  

3. On Work with Task Views, click Find.  

Use the QBE row to refine your search.  

4. Choose a task view, and then click Delete.  

5. On Confirm Delete, click OK. 

Working with Task View Roles and Variants  

You can use roles and variants to customize certain task views or parts of task views for 
specific user groups. Roles and variants define a subset of the tasks in the original task view. 
They allow you to customize and simplify task views.  

Roles apply only to role-based task views and are available only to users who have access to 
those roles. Roles always apply to the entire task view. 

Variants apply to task views that are not role-based and are available to any user. You can 
define a variant for an entire task view by making a variant of the task view node (the first 
node at the top of the task view menu), or you can create a variant of any of the parent tasks 
in the task view.  

You can use roles and variants to make different versions of task objects available to users, 
and you can vary the descriptions of the tasks, as well. Furthermore, when linking to a node 
that has one or more available variants, you can choose to link to the base view or to any of 
the variants instead. The variant does not replace the original task view menu; it is an 
alternative view that the user must apply and clear manually, or that you can cause the 
system to display as the target of a link. When you create a variant of a specific node in the 
task view, the user must know which node to select to be able to apply the variant. 

See Also  

• Working with Task Links in the Solution Explorer Guide 
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Defining a Task View Role or Variant 

To define a role or variant, you refine the task view using the Fine Cut feature, and then save 
the results. You define the role or variant based on your needs analysis of the users.  

► To define a role or variant  

1. In a task view of Solution Explorer, click the Fine Cut button on the Toolbar.  

2. Choose a parent task and expand the task tree to expose tasks that you want to 
disable.  

3. Choose each task that you want to disable, and then click the Disable button.  

4. After you have disabled all of the tasks that you do not want to appear in the variant, 
choose the parent task.  

5. If you are in a role-based task view, right-click and then choose Save Role, and then 
continue to step 6. If you are in a task view that is not role-based, right-click and then 
choose Save Variant from the menu, and continue to step 7.  

6. On Save Role, choose an existing role and then click Select, or create a new role.  

Note 
For information about creating a new role, see Adding a User Role in the System 
Administration Guide. 

 

7. On Create New Variant, type a description of the variant, and then click OK. 

The system saves your changes to the Variant Description (F9005) and the Variant 
Detail (F9006) tables. 

Changing a Role or Variant  

By modifying roles and variants, you can control the configuration of your Solution Explorer 
task view. Overriding the default task name and task version, for example, further 
differentiates a role or variant from the default task view definition. Changing the name and 
version for the role or variant helps you and other users understand the difference between 
the role or variant and the default view. You might want to work with a version of a program 
other than the default version when you are in a certain role or variant view, and you can set 
that version with an override. After you have set the override, you do not have to change the 
version for the task in the role or variant again, unless you want to change it.  

The changes that you make to the role or variant, such as assigning new task names, apply 
only to that role or variant. The system preserves the properties that define the default task 
view. You are not replacing the original view; you are creating an alternative view to be used 
in specific situations that your business requires.  

► To change a role  

1. In a Solution Explorer task view, click the Fine Cut button on the Toolbar.  

2. Right-click the root task in the task view, and then choose View By Role from the 
menu.  

3. On View by Role, choose the role that you want to change, and then click Select.  
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4. Double-click a task to make its relationship active or inactive, or right-click a task in 
the task view and choose Override Name to change the task name. 

5. Right-click the task view root task and choose Save Role. 

6. Choose the role, and then click Select. 

7. Click Fine Cut to exit Fine Cut Mode. 

► To change a variant  

1. In a task view of Solution Explorer, click the Fine Cut button on the Toolbar.  

2. Select the parent task of the task relationship that has a variant.  

3. Right-click the parent task, and then choose Manage Variants from the menu.  

4. On Variant Name Search & Select, choose the variant you want to change, and then 
click Select.  

The Variant Definition form appears, displaying all of the child tasks under the current 
node.  

Alternately, you can access the Variant Definition form from the Content 
Development Tools task view. Launch the Work With Variants task, and then find and 
select the variant you want to change.  

5. Change the columns in the rows as desired, and then click OK:  

• Active  

• Override Task Name 

• Override Task Version 

6. Close the Variant Name Search & Select form.  

7. Click the Fine Cut button to exit Fine Cut Mode.  
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Task Set Up  

To design and manage your system, you work with tasks, which are units of work that you 
use to build essential business processes. Tasks can be interactive programs, batch 
programs, constants, next numbers, Microsoft Windows executables, and so on. You work 
with tasks in a Solution Explorer task view, which is a collection of related tasks that are 
hierarchically grouped in parent-child relationships and illustrated graphically by the task view 
menu. These task groups usually represent the steps in an essential business process such 
as Procure to Pay.  

J.D. Edwards provides a large selection of tasks that are already grouped in relationships 
within different task views. You can modify already existing tasks and their relationships. You 
can also create new tasks, task relationships, and views.  

Within a task view, you insert new or existing tasks and arrange the tasks in logical 
sequences. You create or revise tasks on an ongoing basis, and then insert them in a task 
view as necessary to build and enhance your business processes. The processes are fluid; 
that is, you can drag and drop tasks and task relationships to change the relationships and 
the order in which you perform tasks.  

The system stores each task in a task view in the Task Master table (F9000) and assigns a 
unique ID to each one. Each task is a reusable object that you can insert into an existing task 
relationship, or you can use as a basis for creating a new task relationship. After you have 
inserted a task in a task view, you can move it, revise it, write documentation for it, set up 
processing options, set up versions, and locate it. You can accomplish any of these functions 
in a Solution Explorer task view by launching interactive programs or using features and 
functions that are included in Solution Explorer.  

The following list contains a description of each of the task types: 

Interactive  

Use this category for interactive J.D. Edwards software programs (with the exceptions of AAI 
and constants programs). When the user runs this task, the program runs. You can define 
which version of the program and even which form you want the task to launch, if desired. 
You can also control whether the user is prompted for processing options and in what mode 
(default, add, update, delete) the form opens open. You typically use this last parameter only 
when the task will be used in a Universal Director process. 

Batch  

Use this category for batch J.D. Edwards software programs (such as reports). When the 
user runs this task, the system submits the batch program for processing. You can define 
which version you want the task to launch. You can also control how the system prompts the 
user to set processing options and data selection.  

Windows  

Use this category for Microsoft Windows executable files. When the user executes this task, 
the system calls the Microsoft Windows program. To use this option, you define the 
executable, its working directory, and the command-line parameters that you want to pass to 
the program.  
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Folder  

Use this category to create graphic placeholders in a task view. For example, you might want 
to group a number of procure-to-pay batch programs within the tree structure. You can create 
a folder task called Procure to Pay Batch, make it the parent task, and then place all of the 
batch-related tasks under it.  

Nonsoftware  

Use this category to represent nonsoftware tasks in a task view. For example, you might want 
a task that represents an internal discussion or a project that should occur in a specific 
sequence within an activator. You can create a nonsoftware task called Determine Team 
Members to act as the parent task, and then place all of the team tasks under it. 

Activity Script  

Use this category to define HTML-editable documents that are attached to Solution Modeler 
tasks.  

User Defined Code  

Define a task as a User Defined Code to access the Work with User Defined Codes form 
(W0004AA). The parameters that you define for this task type (product code and UDC) are 
passed to the form so that the user can work with the UDC set that you specify.  

Processing Option  

Define a task as a processing option to displays the processing options for the program that 
you specify. You can also define the program version and the mode in which the form 
appears.  

AAI  

Use this category for interactive J.D. Edwards software programs that affect automatic 
accounting instructions. This type of task is identical to the Interactive task type except, that 
its icon in the task view menu is different from the Interactive task type icon.  

Constant  

Use this category for interactive J.D. Edwards software programs that affect the constant 
values for a system. This type of task is identical to the Interactive task type, except that its 
icon in the task view menu is different from the Interactive task type icon.  

Next Number  

Use this category to create a task that displays the Set Up Next Numbers by System form 
(W0002C) when you execute the task. This task type requires the product code of the system 
that you want to affect.  
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See Also  
! Task View Setup in the Solution Explorer Guide  

! Working with Task View Roles and Variants in the Solution Explorer Guide 

! Working with Task Links in the Solution Explorer Guide 

Creating a Task  

The tasks in task views are reusable objects that add to the flexibility of the Solution Explorer. 
Tasks reside in the Task Master table (F9000).  

You can create a new task directly in the Solution Explorer by inserting a new task in a task 
view menu. You define the task using the Task Revisions form. When you create a task, you 
automatically create a relationship between the new child task and the parent task under 
which you inserted the new task.  

Before You Begin  
! If you are creating a task to launch an object such as a program, verify that the object 

already exists in the system. For example, you might want to design a new report and 
then make it available for processing via a task in a task view. Before you can create 
a task that launches a report, you must first design and check in the report.  

► To create a task  

1. In a task view, choose the task that will be the parent of the task that you want to 
create.  

2. Right-click the task and choose Insert New Task from the menu.  

3. On Task Revisions, complete the following field.  

• Task Name 

4. Choose the Common tab, and then complete the following fields:  

• Product Code 

• Activator Type                           

Complete this field only if you plan to use this task as part of a Universal Director 
process.  

• Client Platform 

Leave this field blank if the task that you are creating runs on both Windows and 
Web clients. Otherwise, enter W to specify web client only, or C to specify 
Windows client only.  

• Country Code 

Leave this field blank if you want this task to be available for all users, regardless 
of their country codes. Otherwise, enter the country code that must be assigned 
to users before they can access this task.  

• Required 

Leave this field blank unless you plan to use this task as part of a Universal 
Director process.  
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• Active 

Deactivating a task makes it unavailable to users in any task view. Generally, you 
want to keep your new tasks active.  

5. Choose the Executable tab, and then choose one of the following task type options:  

• Interactive 

Turn on this option for a task that launches an interactive J.D. Edwards software 
program.  

• Batch 

Turn on this option for a task that launches a J.D. Edwards software batch 
program.  

• Windows 

Turn on this option for a task that launches a Windows-based executable.  

• Folder 

Turn on this option for a task to be used as an activity or nonsoftware 
placeholder in a task view. This task does not execute a function, but might have 
accompanying documentation that describes the activity. 

• User Defined Code 

Turn on this option for a task that launches a program that allows a user to 
modify UDC tables.  

• Processing Option 

Turn on this option for a task that displays processing options for a program.  

• AAI 

Turn on this option for a task that launches an automatic accounting instruction 
program.  

• Constant 

Turn on this option for a task that launches a program that allows the user to 
modify constants.  

• Next Number 

Turn on this option to launch the Set Up Next Numbers by System form.  

• Activity Script 

Turn on this option for a task to be used as HTML text to be attached to a 
modeler task.  

• J.D. Edwards Workflow 

• Non-Software 

Turn on this option for a task to be used as a placeholder in a task view. This 
task will not execute a function, but will be used to organize tasks in the tree.  
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Note 
Many of the task type options require that you enter additional information. For 
example, if you choose Interactive as a task type, you must supply the object name 
for the program, the version, form names, and set up processing options, if any. 
Steps 6 through 12 list the fields that you must complete for the task type options that 
require additional information. 

 

6. If you turned on the Interactive, AAI, or Constant option, complete the following fields: 

• Application 

Enter the object name of the program.  

• Version                                  

Complete this field only if you want to launch a specific version of a program. 
Click the Visual Assist to search for a version.  

• Form 

This is an optional field. To open a specific form in the program, enter the 
form ID. Click the Visual Assist to search for a form.  

• Option Code                              

• Form Mode 

Leave this field blank unless you plan to use this task as part of a Universal 
Director process.  

• Application Type 

7. If you turned on the Batch option, complete the following steps: 

a. Complete the following fields: 

• Application 

• Version                                  

This is an optional field. To launch a specific version of a batch program, 
enter the version.  

b. Choose one of the following options: 

• No Processing Options 

Turn on this option to execute the batch program without processing options.  

• Blind Execution 

Turn on this option to execute the batch program without displaying its 
processing options.  

• Prompt for Version 

Select this option if you want to prompt the user to select which version of the 
batch program to run at execution.  

• Prompt for Values 
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Select this option if you want to prompt the user to enter processing option 
values at execution.  

• Data Selection 

Select this option if you want to prompt the user to enter data selection at 
execution.  

• Data Selection and Values 

Select this option if you want to prompt the user to enter data selection and 
processing option values at execution.  

8. If you turned on the Windows option, complete the following fields: 

• Windows Executable                       

Enter the executable name.  

• Working Directory                        

This is an optional field. Enter the directory in which the executable resides.  

• Executable Parameters 

This is an optional field. Enter any input commands, functions, or parameters that 
you want to pass to the executable when it launches. Not all Windows 
executables accept parameters at launch.  

9. If you turned on the User Defined Code option, complete the following fields: 

• Product Code 

• User Defined Codes 

10. If you turned on the Processing Option option, complete the following fields: 

• Application 

• Version                                  

This is an optional field.  

• Option ID 

11. If you turned on the Next Number option, complete the following field: 

• Product Code 

12. If you turned on the J.D. Edwards Workflow option, complete the following field: 

• Process ID 

13. Choose the Resources tab, and then complete the following fields:  

• Base Resource 

• Base Units                               

• Unit of Measure                          

14. To apply roles to the task, choose Roles from the Form menu.  

15. On Role Definition, choose the role that you want to apply to the task, and then 
choose Change Status from the Row menu.  
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A checkmark appears to indicate that the role is applied to the task. To remove a 
checkmark, choose Change Status from the Row menu again. To apply all roles to 
the task, choose Enable All from the Form menu.  

16. Click Close.  

17. On Task Revisions, click OK.  

See Also 
! Activators in the Solution Explorer Guide for more information 

Working with Tasks  

The tasks in task views are reusable objects, which adds to the flexibility of the Solution 
Explorer. Not only can you create tasks and insert them into the appropriate task view, but 
you can also build tasks into task relationships that represent key business processes. You 
can also move tasks freely within a task view by dragging and dropping them into the 
appropriate task relationship. You can revise task properties, set processing options and 
interactive versions, and reuse the same task in as many different task relationships as 
necessary.  

Tasks reside in the Task Master table (F9000).  

Inserting an Existing Task  

When you insert a task and thereby create a task relationship, the system stores the parent-
child relationship that you create in the Task Relationships table (F9001). The system also 
stores the task view into which you inserted the task.  

Because tasks are reusable objects, you can insert the same task into multiple task views.  

► To insert an existing task  

1. In a task view of Solution Explorer, choose a task that will be the parent of the task 
that you want to insert.  

2. Right-click the parent task, and then choose Insert Existing Task from the menu.  

The Task Relationship Revisions form appears. The form displays the parent task ID 
and all tasks that are children of the parent task that you chose.  

3. On Task Relationship Revisions, click a new line, and complete the following required 
fields:  

• Child  Task ID 

• Presentation Sequence 

If you want the task that you are inserting to appear in a position other than last 
in the presentation sequence, change the presentation sequence of the other 
tasks. For example, if the task that you are inserting is in the eighth position, but 
you want it to appear second, change the presentation sequence of the task that 
is currently second to third, the third to fourth, and so on.  

4. If you plan to use this task as part of a Universal Director process, complete the 
following fields: 
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• Required 

• Activator Type 

• Auto Data Passing 

• Override Form Mode 

5. Complete any of the following optional fields:  

• Active 

• Task View 

• Override Units 

• Unit of Measure 

6. Click OK.  

See Also 
! Working with Task Links in the Solution Explorer Guide 

Setting Default Processing Options for a Task  

You can set processing options, if they exist, for an interactive, AAI, constant, or batch 
program task. Even though you input the values, the user can still change the values when 
he or she launches the task.  

► To set processing options for a task  

1. In a task view of Solution Explorer, choose an interactive, AAI, constant, or batch 
program task.  

2. Right-click the task, choose Prompt for, and then choose Values from the menu.  

The system launches the processing options form for the task. If the program does 
not have processing options, the Prompt for Values option is disabled.  

3. Enter processing options for the task, and then click OK.  

Setting Versions for a Task  

You can choose which version of an object a task runs.  

► To set versions for a task  

1. In a task view of Solution Explorer, select an interactive, AAI, constant, or batch 
program task.  

2. Right-click the task, choose Prompt for, and then choose Versions. 

The Work With Versions form or Work With Batch Versions form appears.  

3. Set up the interactive or batch version, and then click OK.  
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Applying Roles to a Task 

You apply roles to tasks so that the tasks will be filtered properly in role-based task views. 
You can apply one or more roles to each task.  

When a user launches a role-based task view, the system applies his or her login role to the 
view. If the system administrator has applied other roles to that user, he or she can apply 
them to the task view to see a different set of tasks.  

For example, a user might have two roles, General Accounting Clerk (the user's sign on role) 
and Accounts Payable Clerk. When the user launches a role-based task view, the system 
displays only those tasks to which the General Account Clerk role has been applied, such as 
Autoreconcile Void Payments, Autoreconcile Void Receipts, and Refresh Reconciliations File. 
The user can apply the Accounts Payable Clerk role to the task view, and the system 
displays only those tasks to which the Accounts Payable Clerk role has been applied, such 
as Speed Status Change, Create Payment Groups, and Work with Payments. 

Users can switch roles only if they sign on to Solution Explorer with the *ALL role. If a user 
signs on with the *ALL role and then accesses a role-based task view, then the user can view 
all tasks that are visible to any of the roles assigned to the *ALL role. 

For example, the *ALL role contains Role1 and Role2, but not Role3. When a user accesses 
a role-based task view, Solution Explorer displays all of the tasks that are available in Role1 
or Role2. Tasks that are only available to Role 3 do not appear. 

► To apply roles to a task  

1. In a role-based Solution Explorer task view, choose the task to which you want to 
apply roles.  

2. Right-click the task, and then choose Task Revisions.  

3. On Task Revisions, choose Roles from the Form menu.  

4. On Task Where Used, click Find.  

5. Choose the parent of the task to which you want to apply roles, and then click Select.  

6. On Role Definition, choose the role to which you want to apply to the task, and then 
choose Change Status from the Row menu.  

A checkmark appears to indicate that a role is applied to the task. To remove a 
checkmark, choose Change Status from the Row menu again. To apply all roles to 
the task, choose Enable All from the Form menu.  

7. Click Close.  

8. On Task Revisions, click OK.  

Note 
You can also use Fine Cut to filter tasks for certain roles. 
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See Also 
! Working with Task View Roles and Variants in the Solution Explorer Guide  

! Creating a Task in the Solution Explorer Guide for information about applying roles to 
a new task when you create it  

! Setting Up User Roles in the System Administration Guide for information about 
applying roles to users 

Changing a Task  

When you change a task using this process, you affect all instances of the task in the 
Solution Explorer.  

► To change a task  

1. In a Solution Explorer task view, select the task that you want to change.  

2. Right-click the task, and then choose Task Revisions from the pop-up menu.  

3. On Task Revisions, complete any changes that you want to make to the task, and 
then click OK.  

Synchronizing Task Names and Task Status between Solution Modeler and 
J.D. Edwards Software 

To ensure that the task names that you create in Solution Modeler display in Solution 
Explorer and update the appropriate J.D. Edwards table, you export the tasks names from 
Solution Modeler into J.D. Edwards software. The method by which you perform this process 
is called Synchronize Names. 

Solution Modeler 

Solution Modeler is a J.D. Edwards application that enables you to create visual 
representations of your business, process, and workflow models. Each step, or task, in your 
model can contain tasks that relate specifically to that particular point in the process. For 
example, your model might contain the task Enter Into Inventory; within this task, you can list 
the steps for entering a task into inventory. 

Solution Modeler is fully interactive with J.D. Edwards software. You can create and manage 
models that launch corresponding applications for each task of the model, which enables you 
to work in the application that your model represents. For example, if your model contains a 
Sales Order Entry task, you can link the task to the Sales Order Entry application in 
J.D. Edwards software so that the application launches from Solution Modeler. You can 
complete the required tasks in the application, and then return to Solution Modeler to view the 
next task in the model. 

Included in the Solution Modeler are several hundred pre-configured process models. Each 
task that is linked to a J.D. Edwards software application appears in the J.D. Edwards task 
database table (F9000). Therefore, if you change the properties of one task using the 
Properties Context menu option in Solution Modeler, you do not need to update the J.D. 
Edwards tables for the change to appear in Solution Explorer the next time the task 
information is retrieved from the database. If you add a task to a model and want it to appear 
in a Task View, you must assign the task a relationship; that is, a location in the task view. If 
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the task view to which you assign the task is a role-based task view, you can assign one or 
more roles. Only those users with corresponding roles can see your task in that role-based 
task view; however, if you change the Solution Modeler task name without using the 
Properties Context menu option, the change is not updated automatically in the F9000 table. 
To ensure that the J.D. Edwards database is updated with the data in Solution Modeler, use 
the Synchronize Names feature in Solution Explorer. 

Synchronizing Task Names 

When you use the Synchronize Names feature, Solution Explorer retrieves from Solution 
Modeler a list of the task IDs and task names that are associated with J.D. Edwards tasks. 
Solution Explorer updates the F9000 table in the J.D. Edwards database so that Solution 
Explorer displays the updated task names the next time task information is retrieved from the 
database. Information is retrieved from the database when you log in to J.D. Edwards 
software or when you change task views.  

► To synchronize task names 

From the Tools menu, choose Solution Modeler and then choose Synchronize Names. 

Synchronizing Task Statuses between Solution Modeler and J.D. Edwards 
Software 

When you synchronize task statuses, Solution Explorer retrieves from Solution Modeler task 
IDs and task statuses that are associated with tasks in J.D. Edwards software. Synchronizing 
tasks updates the active or inactive option of the task in the Task Master table (F9000) in the 
J.D. Edwards software. The active or inactive option of a task determines whether a task is 
visible in any task view. When a task is set to inactive, it does not appear in any task view. 
When a task is set to active, it appears in any task view in which a task relationship has been 
defined for it and it has not been filtered out by a mechanism such as FineCut. In a role-
based task view, the tasks that you see in Solution Explorer depend upon the role that you 
are assigned and the role or roles that are assigned to the tasks.  

See Also 
! Task View Setup in the Solution Explorer Guide 

► To synchronize a task status 

From the Tools menu, choose Solution Modeler and then choose Synchronize Tasks. 

Deleting a Task  

You can delete an instance of a task from a task view menu. However, performing this action 
does not delete the task itself; it merely eliminates the task from the relationship. To delete a 
task from the system, you must use the Work With Tasks program (P9000) to locate the task 
and then delete it from the Task Master table (F9000).  

Deleting an Instance of a Task  

You can delete a task from a relationship in a task view of Solution Explorer. Doing so 
deletes the task only from the task view; it still exists in the Task Master table (F9000) and in 
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any other relationship in which it has been inserted. Furthermore, you can still insert it into 
other task menus.  

► To delete an instance of a task  

1. In Solution Explorer, open the task view that contains the task relationship that you 
want to delete.  

2. Right-click the task that you want to delete, and then choose Delete Relationship 
from the menu.  

3. On Delete Relationship, click OK. 

Deleting a Task from the Task Master Table (F9000) 

To delete a task from the system completely, you must delete it from the Task Master table. 
Before you can do so, however, you must first delete all of the relationships for the task. This 
is equivalent to deleting the task in each task view menu in which it appears.  

► To delete a task from the Task Master table (F9000) 

1. In Solution Explorer, choose Work With Tasks from the Tools menu.  

2. Click Find.  

Use the QBE row to refine your search.  

3. Choose the task that you want to delete, and then choose Where Used from the Row 
menu.  

4. On Task where Used, search for the parent of the current task by clicking Find.  

The task might have more than one parent. If so, all of the parents appear.  

5. Choose the parent of the task that you want to delete, and then click Select.  

6. On Task Relationship Revisions, choose the task that you want to delete, and then 
click Delete.  

7. On Confirm Delete, click OK. 

8. Click OK.  

9. Repeat steps 5-8 for each parent of the task in the list.  

10. On Task where Used, click Close.  

11. On Work With Tasks, choose the task that you want to delete, and then click Delete.  

12. On Confirm Delete, click OK. 

Finding Solution Explorer Task and Task Relationship Changes in Object 
Management Workbench 

When you change tasks or task relationships in Solution Explorer, the change is logged in 
Object Management Workbench (OMW). If you have added or deleted tasks or task 
relationships, the information is stored in OMW so that you and others can easily find the 
tasks and task relationships that have changed. If you changed task properties from within 
the Work With Tasks program (P9000), the task is logged in OMW. 
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Note 

For your changes to be logged in OMW, your system administrator must have turned on 
OMW logging in the Security Workbench program (P00950) for your user ID. To determine 
whether your OMW logging is turned on, double-click the lock icon on the Solution Explorer 
status bar. 

 

See Also 
! Working with Security Workbench in the Object Management Workbench Guide for 

more information about Object Management Workbench 

Working with Task Links  

A task link is a shortcut to another task. The linked task appears in an alternate window in the 
Solution Explorer, so you can still see your point of origin. Typically, links are made to tasks 
with children (nodes). When you link to a node, all of its children are visible in the new 
window.  

You can link to any task in any task view except for the task view node itself. Optionally, you 
can link to a task view variant. To create a task link, you revise the task relationships. You 
cannot link to a task view node.  

When you create links, you must identify the two members in the link: the task from which 
you are linking and the task to which you are linking. The task from which you are linking is 
called the link task. The link task displays the link indicator. The task to which you link, called 
the link target, appears in the second window.  

You can create a link to a variant when you link task views as part of completing a business 
process. You might decide that users who link from one task view to another need variants of 
a task relationship.  

To delete links, you revise the task relationships.  

► To create a link to a task  

1. In a task view of Solution Explorer, choose the parent of the task that you want to 
make the link task.  

2. Right-click the task that you chose, and then choose Task Relationships.  

3. On Task Relationship Revisions, click Find. 

4. From the list of tasks, click the task that you want to set up as the link task, and then 
choose Link To from the Row menu.  

5. On Link To, click the Find Relationship button.  

6. On Find Relationship, complete the following fields, and then click Find:  

• Task View 

• Parent Task ID  

Enter the parent of the task that you want to set up as the link target.  

The Find Relationship form lists all of the child tasks of the parent you searched on.  
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7. Choose the task that you want to set as the link target, and then click Select.  

The link target is the task that appears in the second window when the user invokes 
the link. The system uses the information that you provided to complete the required 
fields in the Link To form.  

8. On Link To, click OK.  

9. On Task Relationship Revisions, click OK.  

The link task appears in the task view with a red arrow to indicate that it links to 
another task.  

Before You Begin  
! Apply the variant to the task link child.  

► To create a link to a variant task view menu  

1. In a task view of Solution Explorer, choose the parent of the task that you want to 
make the link task.  

2. Right-click the task that you chose, and then choose Task Relationships.  

3. On Task Relationship Revisions, click Find. 

4. From the list of tasks, choose the task that you want to set up as the link task, and 
then choose Link To from the Row menu.  

5. On Link To, click the Find Relationship button.  

6. On the Find Relationship form, complete the following fields, and then click Find:  

• Task View 

• Parent Task ID  

Enter the parent of the task that you want to set up as the link target.  

The Find Relationship form lists all of the child tasks of the parent for which you 
searched.  

7. Choose the task that you want to set as the link target, and then click Select.  

This is the base of the variant task view that appears in the second window when the 
user invokes the link. The system uses the information that you provided to complete 
the required fields on the Link To form.  

8. On Link To, complete the following field with the Variant ID: 

• Link to Variant 

This is the variant task view that users see in the second window when they activate 
the link. Use the Visual Assist in the Link to Variant control to locate the variant to 
which you want to link.  

9. Click OK.  

10. On Task Relationship Revisions, click OK.  

The link task appears in the task view with a red arrow to indicate that it links to 
another task.  
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► To delete a link  

1. In a task view of Solution Explorer, choose the parent of the task that contains the 
link that you want to remove.  

2. Right-click the task that you choose, and then choose Task Relationships from the 
menu.  

3. On Task Relationship Revisions, choose the task with the link that you want to 
delete, and then choose Remove Link To from the Row menu. 

4. Click OK.  

The system removes the link.  

Documenting Tasks  

Task documentation allows new system users to review the purpose of a task, the steps 
required to complete it, and the information that they need to know before they begin a task. 
Task documentation enables other users to create notes that clarify a business process and 
to provide links to other documents that result from completing a task, such as an invoice.  

Many J. D. Edwards tasks already have documentation when you install the Solution 
Explorer. However, you can edit documentation using the Solution Explorer toolbar and an 
HTML editing tool, such as Microsoft Word. In addition, you can use your editing tool to write 
your own documentation.  

Warning 

Any modifications that you make to J. D. Edwards-provided documentation will be lost when 
you update your system. Documentation you create yourself, however, will remain intact.  

 

The Solution Explorer task view includes a documentation window, which displays task 
documentation in HTML format. When you categorize a piece of documentation for the 
Solution Explorer, you define it as being one of several instruction types, including Summary, 
Detail, Before You Begin, Notes, Deliverables, or Custom. These instruction types 
correspond to the names of the tabs that appear in the documentation window. For example, 
you might create two documents, one that you define as Summary and another that you 
define as Detail. Consequently, users who review documentation for that task will see two 
tabs in their documentation window: Summary and Detail. The documentation window is 
available both in the Solution Explorer and within the Universal Director.  

Task Documentation Order of Precedence  

The following steps describe how the system determines the information to display in the task 
documentation window. For each task, the system performs these steps for every 
documentation category in the system.  

1. The system determines whether documentation has been associated with the current 
task. If such documentation exists, the system displays that documentation. If not, the 
system proceeds with the following step.  

2. If no documentation is available on the task level, the system determines whether 
documentation has been associated with the task view. Task view documentation is 
actually associated with the task view node (the first task at the top of the task view). 
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If such documentation exists, the system displays that documentation. If not, the 
system proceeds with the following step.  

3. If no documentation is available on either the task or the task view levels, the system 
determines whether global documentation resides in the root of the documentation 
directory. If this documentation exists, the system displays it in the documentation 
window. If this documentation does not exist, the system does not display a tab for 
that category.  

You can create and edit global documentation, but you must do so outside of the Solution 
Explorer. Note that each category uses a different file for global text. For example, to create 
global documentation for both the Detail and Consequence categories, create two files: 
detail.htm and consequence.htm.  

During the search process, the system does not search for documentation that is associated 
with parent tasks. For example, in a task view, a parent task might contain a child task. Even 
if the parent task has documentation associated with it, if the child task has not 
documentation, the system displays the documentation that is associated with the task view, 
and not the documentation that is associated with its parent.  

Working with Documentation  

You can write documentation of different types for any task in the Solution Explorer task view. 
Documentation might provide general information about a task, specific steps that you follow 
to complete a task, discussion of steps to take before you begin a task, or information that 
you customize for a particular task.  

When you choose Show and then Task Documentation from the View menu, the 
documentation appears in the Solution Explorer documentation window each time that you 
choose a task in a task view. Tabs in the documentation window represent documentation 
instruction types that exist for a task. If you have no documentation for the task, you can 
display a Web site or HTML message for each the task.  

To create the documentation, you click the arrow on the Edit button in the documentation 
window toolbar and choose the type of documentation that you want to provide.  

The system allows you to revise documentation that you have already written. To revise 
documentation, click the Edit button in the documentation window, open the document, make 
changes, and save it.  

 

Before You Begin  
! In the Solution Explorer, from the View menu, choose Show and then Task 

Documentation. This option displays the task documentation window.  

► To create documentation for tasks  

1. In a task view of Solution Explorer, choose a task or task view.  

The documentation appears in the documentation window.  

2. In the documentation window, click the arrow on the Edit button in the documentation 
pane.  

3. Choose an instruction type from the drop-down menu.  

The Solution Explorer Documentation form appears.  
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The Solution Explorer Documentation form contains the file name, which refers to the 
instruction type that you chose and the full path to the documentation file that you are 
writing.  

4. Click Yes to continue.  

The system launches the editing tool that you use in your system, such as Microsoft 
Word.  

5. Using the editing tool, write the documentation.  

6. Save and close the document when you are finished.  

The system creates a tab that represents the documentation instruction type that you 
created. You might need to click Refresh to see the new documentation.  

Before You Begin  
! In the Solution Explorer, from the View menu, select Show and then select Task 

Documentation. This option displays the task documentation window.  

► To revise documentation  

1. In a task view of Solution Explorer, select a task containing documentation you want 
to revise.  

The documentation appears in the documentation window.  

2. Click the tab that represents a type of previously created documentation, such as 
Summary.  

3. Click Edit.  

The system launches the editing tool that you used to create the documentation, and 
retrieves the HTML file you created.  

4. Edit the existing document.  

If your HTML editor is Microsoft Word, the document might appear blank initially. In 
the Microsoft Word toolbar, click View, and then choose HTML Source. You can now 
edit the HTML document.  

Note 
If the documentation's Special Handling parameter is blank, you cannot edit the file. 
When you click the pencil button, the Solution Explorer Documentation form informs 
you that the file cannot be edited.  

 

5. Save and close the document when you are finished.  

You might need to click Refresh to see the new documentation.  
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Adding a Documentation Category  

Instruction types refer to the category of documentation for tasks in your system. For 
example, Summary is an instruction type that provides a high-level overview and definition of 
the task. The system allows you to create an instruction type for your system by adding a 
type to UDC table H90/IN, which stores instruction types and information about them. Each 
documentation type is identified by its own tab in the documentation window.  

When you add an instruction type, you can use the Special Handling Code field to indicate 
whether want to allow users to edit the documentation files. Complete this field in one of the 
following ways: 

• Enter E. This value indicates that the instruction type appears in Solution Explorer 
and is editable. 

• Enter N. This value indicates that the instruction type does not appear in Solution 
Explorer.  

• Leave the field blank. This value indicates that the instruction type appears in 
Solution Explorer, but is not editable. 
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Activators  

To make the process of working through a series of tasks easier and less time consuming for 
end users, Solution Explorer provides a way to group tasks together. A group of tasks is 
called an activator. The system displays the group of tasks to the user with a tool called the 
Universal Director. With the Universal Director, users can work through tasks sequentially by 
clicking the Next button after they complete each task. For example, you can create an 
activator that includes the steps necessary to close a financial quarter.  

Understanding Activators  

An activator is a sequential series of tasks that are required to perform a process that is 
integral to the functioning of your business.  

The task that can launch an activator is always a parent task and is designated by an 
activator flag. Typically, the launching task is a nonsoftware task under which the rest of the 
activator tasks reside. After you have created the activator, users who execute the activator 
launch the Universal Director, a feature that provides a self-contained area in which you work 
with all of the tasks in the relationship. While you are using the Universal Director to run 
activator tasks and task relationships, the system uses data mapping to pass data between 
tasks in the task relationship. The Universal Director guides you through each step of the 
process until you reach completion.  

You use the Solution Explorer task view to make changes to the activator. Any changes that 
you make to the task relationships appear automatically when the user runs the Universal 
Director.  

Activator Flags  

An activator flag designates a task as a parent task under which the rest of the activator tasks 
reside. To enable an activator flag, you enter an activator type on the Task Revisions form of 
the Work with Tasks program (P9000). When the activator flag is turned on, the task name 
displays a light bulb symbol in the task view.  

Double-clicking the activator launches the Universal Director. The Universal Director presents 
each of the tasks in the process in sequential fashion. Within the Universal Director, users 
work with any interactive and batch programs that they need to complete the business 
process that is associated with the activator.  

Any sequence of tasks constitutes a task relationship in a broad sense. The tasks that you 
link together might be tightly related. However, when you designate a parent task as an 
activator and launch the Universal Director, the system formally presents the tasks together 
in one unifying view. In addition, the system passes data between forms without hard-coded 
form interconnections. To alter a business process that is keyed by an activator, you change 
the task relationship in the Solution Explorer task view.  

In addition, you can designate the type of activators that you want to set up. Activator types 
include business and technical activators. Although the activator type does not affect how the 
activator works, by defining an activator as one type or another, you can more easily search 
for an activator.  

You use business activators to implement rapid change to your system without having to 
consume development resources. You designate a task as a business activator if it is a part 
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of the essential processes of your system. For example, a task such as New Company 
Acquisition would be a business activator. It triggers a process that links together a sequence 
of related tasks, each of which you complete in a specified order to accomplish the goal. 
Other business activators might include adding a warehouse or creating customized reports 
and invoices.  

You designate a task as a technical activator if it is part of the management and maintenance 
of your system infrastructure. Technical activators offer simplified system management in 
such areas as permissions, server administration, and component interfaces. For example, 
these activators allow information technologists to implement and maintain a package 
installation process. Technical activators, which automate processes such as these, help 
technical professionals ensure that the system performs at its maximum capability.  

Universal Director  

Activators enable you to create task relationships and pass data between forms without 
writing code that is embedded in event rules or in a workflow process. The Universal Director 
creates a compact area in which users view and work with the tasks in your work process. 
The Universal Director presents the activator and all of the tasks that are related to it in the 
sequence that you specified in Solution Explorer.  

The Universal Director allows you to move forward and backward within the task sequence, 
and it clearly displays your position within that sequence. You accomplish this movement 
within the view by using the director bar.  

The Documentation view is also visible when you are working with the Universal Director. In 
the Universal Director view, the system displays the documentation that corresponds to the 
particular task with which you are working. You can manipulate and edit the documentation 
while you work in the Universal Director, just as you can from Solution Explorer.  

The Universal Director presents another view of the activator parent-child task relationships 
that exist in the Solution Explorer task view. However, it also provides the interface for you to 
execute the tasks in those relationships.  

Data Mapping  

The Universal Director provides data mapping, which passes data between forms as you 
work on the tasks in the sequence. This data mapping mechanism ensures that you can pass 
data between forms logically without hard-coding form interconnections.  

During data mapping, the Universal Director validates that a value-containing header control 
or grid column in one form has a header control or grid column match in the next form. If the 
match exists, the Universal Director passes the value. If no match exists, data mapping fails, 
and the Universal Director generates an error message. You activate data mapping by 
entering Y in the Auto Data Passing grid column in the Work With Tasks program (P9000) for 
each task that is to pass data to another task within the task relationship.  

Creating an Activator  

To create an activator, you first need to create and designate a parent task as the launch 
task, and then you turn on the activator flag for that task. A launch task is the parent task of a 
relationship that constitutes a key business or technical activator. Typically, launch tasks are 
nonsoftware tasks. You create them in the same way in which you create any other kind of 
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task. A task that you have designated as an activator appears in the task view with a lightbulb 
symbol.  

After you create the launch task, you can place as many child tasks under it as you require to 
complete the process. Then, when you select the launch task and click the Run button, the 
system launches the Universal Director. From the Universal Director, you can step through 
the entire sequence from beginning to end and work in any programs that you need to 
complete the process.  

► To create an activator  

1. In a Solution Explorer task view, create or choose a nonsoftware task.  

If you chose a task, right-click the task, and then choose Task Revisions.  

2. On Task Revisions, complete the required fields and options on the Common, 
Executable, and Resources tabs, making sure to enter either a 1 or a 2 in the 
Activator Type field, and then click OK.  

The system places a lightbulb symbol on the task icon to indicate that the task is a 
launch point for an activator.  

3. To finish creating the activator, insert as many tasks that are required to complete the 
transaction in the proper order.  

You can place tasks in the activator by creating them or by sending them to the task 
view from another task view and then dragging and dropping them into their proper 
locations.  

See Also  
! Creating a Task in the Solution Explorer Guide 

Example: Creating an Activator  

This example creates an activator for adding new users to the system. After completing the 
process, you can launch its activator, and then the Universal Director automates the process 
of completing the steps. 

1. Determine the steps required to complete the process.  

Generally, you must decide which programs a user needs to run and the order in 
which the programs need to be run.  

The following list identifies the steps that the users need to complete and the 
programs that are required to complete each step: 
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Add user profile  User Profile Revisions (P0092)  

Add user profile environments  User Profile Revisions (P0092)  

Add user profile security  OneWorld Security (P98OWSEC)  

Add user row security  Security Workbench (P00950)  

Add user action security  Security Workbench (P00950)  

Add user machine  Deployment Locations Application (P9654A)  

Later, each of the previous steps becomes the basis for its own task in the process. 
The task names are not the same as the program names. Although you can use the 
program names as the task names, describing the action to be performed, rather 
than listing the program to use, makes the process clearer to the user. In this 
example, all of the programs are J.D. Edwards software programs.  

Some programs have more than one step applied to them. 

2. Create the parent task.  

This task is the launch task that you will use later in the example. The parent task 
should be a placeholder � a nonsoftware task. When you create the task, complete 
the Task Revisions form as follows. If a field is not mentioned, then leave it blank.  

• Task ID: H95_ADD NEW USER  

• Task Name: Add New User  

• Common tab fields: 

• Product Code: H95  

• Activator Type: 1  

• Active: (selected)  

• Executable tab fields: turn on the Non-Software option  

You must complete the Activator Type field; if you do not, the system does not mark 
the task as a launch task, and the user cannot use the Universal Director to automate 
the child tasks.  

3. Add a task called Add User Profile as the first child of the Add New User task. When 
you create the task, complete the Task Revisions form as follows. If a field is not 
mentioned, then leave it blank.  

• Task ID: H95_ADD USER PROFILE  

• Task Name: Add User Profile  

• Common tab fields  

• Product Code: H95  

• Active: (selected)  

• Executable tab fields:  

• Turn on the Interactive option  

• Application: P0092  
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• Version: ZJDE0001  

• Form: W0092A  

• Option Code: 1  

4. Add the remaining tasks, in order, as children of Add New User that follow the Add 
User Profile task.  

In this example, you are creating all of the tasks for the process. However, you can 
insert already existing tasks into the process, as well. You can also send tasks to the 
task view and then drag and drop them in the correct place.  

Set up each task in the same way in which you set up the last two tasks. Use the 
following parameters on the Executable tab of the Task Revisions form:  

• Add User Profile Environments:  

• Application: P0092  

• Version: ZJDE0001  

• Form: W0092C  

• Option Code: 1  

• Add User Profile Security: 

• Application: P98OWSEC  

• Version: ZJDE0001  

• Form: W98OWSECF 

• Option Code: 1  

• Add User Row Security: 

• Application: P00950  

• Version: ZJDE0001  

• Form: W00950F  

• Option Code: 1  

• Add User Action Security:  

• Application: P00950  

• Version: ZJDE0001  

• Form: W00950M  

• Option Code: 1  

• Add User Machine: 

• Application: P9654A  

• Form: W9654AB  

5. To test the process, click the Add New User activator, and then click the Idea to 
Action button on the Toolbar.  

The steps in the tree on the left of the Universal Director represent the tasks that you 
added to create the process.  
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Standalone Fast Path 

In J.D. Edwards software, Fast Path is a search field that enables you to launch programs, 
user defined codes, tasks IDs, menus, and so forth. The system permissions that your 
system administrator assigns to you determine whether you can access Fast Path.  

Fast Path appears in Solution Explorer. You can, however, also launch the Fast Path 
independently of Solution Explorer. This standalone version of Fast Path enables you to 
quickly launch programs without having to take time for Solution Explorer to fully load. This 
feature is especially useful for users who need Fast Path to launch programs, but do not 
need the navigation or other capabilities of Solution Explorer. 

To use the standalone Fast Path, you must have the J.D. Edwards installed and must be 
signed on to the system. If you are not currently signed on, the system prompts you to sign 
on when you launch the standalone Fast Path executable program. 

► To access standalone Fast Path 

1. Navigate to the directory that contains the J.D. Edwards software. 

2. Click the System directory, and then click the bin32 directory.  

3. Double-click the FastPath.exe file.  

 

 




